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Onboarding New Staff

Key Elements

With the constant rate of staff turnover, it is important that ECS System Supervisors are aware
of all steps involved in onboarding. These steps are outlined below and described in further
detail throughout this handout. There are additional reference handouts attached to this
webinar as well that can be used to provide new staff members who are new to ECS.

Checklist

Gather user information

Create new user in ECS

Create new provider in ECS (if applicable)

Create new Client Sign On user

Provide training

Provide training materials/guidance

Supplemental Handouts
1. User Setup
Fake Residents for Practice
Core Training
Surveyors (NH)
Client Sign On Guide

ok wn

Gather User Information

Before setting up a new user, you will want to determine a few things. First, you will need to
know if they are a temporary employee, such as a nurse aide/nurse student, who will not be at
the facility long-term. If so, they may be setup as a temporary user, rather than a regular user.
The only difference between temporary and regular is that temporary users allow for you to
enter in an end date which no longer allows access to the system with that username after that
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date. This works well if you know for sure that the temporary user will not be in the building
past the date, however, should not be utilized if you are ever unsure. The end date of a
temporary user can be continually extended if needed.

Another user that differs from others is a surveyor. Although their setup is very similar, they
will have a different handout made available to them. In addition, you will want to have
someone check the entire survey user group access to ensure that all buttons work correctly
and load as they are intended. Even the slightest change in a surveyor user group can cause
unattended disruptions in their access. Itis important to test out the survey user group
frequently.

Once you have determined if they are a surveyor or a temporary user, then you will want to
gather the necessary information to get them setup as a user:

1. First Name

2. Last Name

3. Middle Name or initial (this field is not required and may be left blank if needed)

4. Job Title

5. Preferred Login Name (most facilities have a standard they follow for login names)

6. User Group the user should be placed into (the options available will vary per facility,

each user should be placed into a group that most closely aligns with the access they
need)

7. Whether they would like an enlarged font size or not (ECS defaults to size 8 fonts,
which tends to be small for some users, a user may not know if they want enlarged font
until after they begin using ECS which is OK as this can be adjusted at a later time if
needed)

8. Which clients they should have access to (if your facility is a stand-alone nursing home,
there is no need to determine this, however if your facility is a community of care
campus with several levels of care, you will want to know which site(s)/service(s) this
user should have access too).

Once all information has been gathered, the next steps can be followed.

Create New User in ECS

Reference the User Setup handout for further details regarding this topic.

Create New Provider in ECS (if applicable)

Reference the User Setup and/or the How to Enter in a Provider handout for further details
regarding this topic.
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Create New Client Sign On User

The Client Sign On is a location where ECS provides all our client training materials. These are
included as part of your facility's maintenance fees and can be accessed by anyone at the
facility who is provided with a login. The logins for the Client Sign On are managed solely by
your facility. There is one person at each facility who acts as the facility “Administrator” of your
accounts and who can freely add new users and inactive users no longer there. Not all staff
will need access to the Client Sign On, however it is a great resource with training videos,
webinars, and documentation that can assist the user in learning more about ECS and how to
navigate it. If you are unsure who the Client Sign On Administrator for your facility is, feel free
to contact us at American Data and we can provide you with that information.
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Reference the Client Sign On Guide handout to learn how to setup a new user on this site.

Provide Training

Basic training for ECS use may be provided during orientation, or directly on the job.
However, it is important that some form of training occurs. Utilize the Core Training handout
to better assist in which training may be useful to a new user.

Using Fake Residents for Practice

With ECS, there is no test vs. production environment, but rather all users are in the
production database every day. To complete training of new staff or to allow new staff
members to practice within the production environment, we have fake residents built in that
may be utilized. Any documentation, running of reports, starting of MDS assessments, etc.
can be completed on these fake residents without harming the live environment.

Itis important however that users are made aware of this option and are comfortable with
filtering their name list to find these fake residents. Most of our facilities have the fake
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residents stored in the "Other” filter, however there are some that have them stored
somewhere else or keep them in the "Active” filter. Check to be sure where your facility has
fake residents stored before utilizing the attached handout for new staff.

Utilize the attached handout titled Fake Residents for Practice.

Provide Training Materials/Guidance

It is recommended that all users be provided with handouts which relate to their department.
Keep in mind that as ECS is customizable, that the handouts provided on our Client Sign On
may not match exactly to how your system is setup. However, some facilities have created
their own custom handouts or have tweaked ours to match their workflows more closely.

Below is a list of recommended videos/documentation to be reviewed on the Client Sign On
for different types of positions within your facility. If your facility has created more customized
materials, those should be utilized prior to anything on the ECS Client Sign On site.

MDS Coordinator
Videos
1. MDS Category > MDS 101, MDS Manager - About & Using, Writing CAA's, MDS
Reports, IPA Forecast, ICD-10 Coding, IPA Predictor, Troubleshooting the MDS in a
PDPM World, MDS Foundations, Survey Reports (672/802)
2. ECS Basics Category > Documenting in ECS, Log In/Exit/Hide, Editing Features, Using
the View Screen

Documentation
1. Clinical > MDS Category > ICD-10 Coding, IPA Forecast, IPA Tools, MDS Coordinator,
MDS Foundations, MDS Manager - About & Using, MDS Reports, Writing CAA's
2. ECS Basics > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View Screen,
Chat Feature, Notifications
3. Clinical > Care/Service Plans > Care Plans

Dietary/Nutrition Department

Videos
1. ECS Basics Category > Documenting in ECS, Log In/Exit/Hide, Editing Features, Using

the View Screen
2. Clinical > Departments Category > Dietary Department
3. MDS Category > Writing CAA's

Documentation
1. Clinical > Departments Category > Dietary Notes

2. ECS Basics > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View Screen,
Chat Feature, Notifications
3. Clinical > MDS Category > MDS (for Departments), Writing CAA’s
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4. Clinical > Care/Service Plans > Care Plans

Activity Department Director

Videos
1. ECS Basics Category > Documenting in ECS, Log In/Exit/Hide, Editing Features, Using
the View Screen
2. Clinical > Departments Category > Activity Department
3. MDS Category > Writing CAA's

Documentation
1. Clinical > Departments Category > Activities Notes

2. ECS Basics > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View Screen,
Chat Feature, Notifications

3. Clinical > MDS Category > MDS (for Departments), Writing CAA's

4. Clinical > Care/Service Plans > Care Plans

Activity Assistant

Videos
1. ECS Basics Category > Log In/Exit/Hide
2. Clinical > Departments Category > Activity Assistant

Documentation
1. Clinical > Departments Category > Activity Assistant
2. ECS Basics Category > Log In/Exit/Hide

Administrator

Videos
1. ECS Basics Category > Log In/Exit/Hide, Using the View Screen
2. Clinical > Other Category > Survey Entrance Checklist
3. MDS Category > Survey Reports (672/802)

Documentation
1. Clinical > Departments Category > Administrator
2. Clinical > Surveyor Category > Survey Entrance Checklist
3. ECS Basics > Log In/Exit/Hide, Using the View Screen, Chat Feature, Notifications

Social Services Department

Videos
1. ECS Basics Category > Documenting in ECS, Log In/Exit/Hide, Editing Features, Using
the View Screen
2. Clinical > Departments Category > Social Service Department
3. MDS Category > Writing CAA's
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Documentation
1. Clinical > Departments Category > Social Service Department

2. ECS Basics > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View Screen,
Chat Feature, Notifications

3. Clinical > MDS Category > MDS (for Departments), Writing CAA's

4. Clinical > Care/Service Plans > Care Plans

Nurse

Videos

1. ECS Basics Category > Log In/Exit/Hide, Chat Feature, Documenting in ECS, Editing,
Using the View Screen

2. Clinical > Nursing Category > Chart an Admission Assessment, Using the Nursing To
Do List (if your facility uses this feature), Chart a Medicare Note, Chart a Fall or Incident
Note, COVID-19 Vaccination Charting, Using the MAR

3. Clinical > Physician Orders Category > Entering SS Insulin, Entering Allergies, Editing
Medication Orders, Entering IV Medications, Entering Routine and PRN Meds, Entering
Non-Formulary Meds

4. Clinical > CNA > CNA Access for Nurses

Documentation

1. ECS Basics Category > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View
Screen, Chat Feature, Notifications

2. Clinical > Nursing Category > Chart a Fall or Incident Note, Chart a Medicare Note,
Chart an Admission Assessment, Electronic Sign, Nurses Notes, Using the Nursing To
Do List

3. Clinical > Physician Orders Category > Editing Medication Orders, Entering Allergies,
Entering IV Medications, Entering Non-Formulary Medications, Entering Routine and
PRN Meds, Physician Orders (Non-Script)

4. Clinical > Care/Service Plans > Care Plans

DON/Nurse Supervisors

Videos

1. ECS Basics Category > Log In/Exit/Hide, Chat Feature, Documenting in ECS, Editing,
Using the View Screen

2. Clinical > Nursing Category > Chart an Admission Assessment, Using the Nursing To
Do List (if your facility uses this feature), Chart a Medicare Note, Chart a Fall or Incident
Note, COVID-19 Vaccination Charting, Using the MAR, Specific Medications List

3. Clinical > Physician Orders Category > Entering SS Insulin, Entering Allergies, Editing
Medication Orders, Entering IV Medications, Entering Routine and PRN Meds, Entering
Non-Formulary Meds

4. Clinical > Other Category > Diagnosis Entry/Editing/Reports, Survey Entrance
Checklist
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5. Clinical > CNA Category > CNA Access for Nurses
6. MDS Category > Survey Reports (672/802), Writing CAA's

Documentation
5. Clinical > MDS Category > MDS (for Departments), Writing CAA's

6. ECS Basics > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View Screen,
Chat Feature, Notifications

7. Clinical > Nursing Category > Chart a Fall or Incident Note, Chart a Medicare Note,
Chart an Admission Assessment, DON_ADON_Nurse Supervisor, Electronic Sign,
Nurses Notes, Using the Nursing To Do List

8. Clinical > Physician Orders Category > Editing Medication Orders, Entering Allergies,
Entering IV Medications, Entering Non-Formulary Medications, Entering Routine and
PRN Meds, Physician Orders (Non-Script)

9. Clinical > CNA Category > CNA Charting (for Nurses)

10. Clinical > Care/Service Plans > Care Plans

CNA
Videos
1. ECS Basics Category > Log In/Exit/Hide
2. Clinical > CNA Category > CNA Access Charting

Documentation
1. ECS Basics Category > Log In/Exit/Hide

2. Clinical > CNA Category > CNA Access Charting

Housekeeping
Videos
1. ECS Basics Category > Log In/Exit/Hide
2. Clinical > Other Category > Housekeeping

Documentation
1. ECS Basics Category > Log In/Exit/Hide
2. Clinical > Departments Category > Maintenance

Maintenance

Videos
3. ECS Basics Category > Log In/Exit/Hide

4. Clinical > Other Category > Maintenance

Documentation
1. ECS Basics Category > Log In/Exit/Hide
2. Clinical > Departments Category > Maintenance
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Videos
1. ECS Basics Category > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View
Screen

2. Clinical > Other Category > Pharmacy Consultant

Documentation
1. ECS Basics Category > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View

Screen
2. Clinical > Departments Category > Pharmacy Notes

Infection Preventionist Nurse

Videos
1. ECS Basics Category > Log In/Exit/Hide, Documenting in ECS

2. Clinical > Nursing Category > Specific Medications List
3. Clinical > Infection Preventionist Category > Infection Control in ECS, Employee Health
(if used at facility), COVID-19

Documentation
1. ECS Basics Category > Log In/Exit/Hide, Documenting in ECS

2. Clinical > Other Category > Infection Control
3. Clinical > COVID-19 Category > How to Chart SARS-CoV-2 Vaccinations

Admissions
Videos
1. ECS Basics Category > Log In/Exit/Hide, Enter A New Client
2. Clinical > Face Sheet/Diagnosis Category > Demographics & Face Sheets, Diagnoses,
Marketing (if used at the facility)

Documentation
1. ECS Basics Category > Log In/Exit/Hide, Enter A New Client

2. Clinical > Face Sheet/Diagnosis Category > Demographics & Face Sheets, Diagnoses,
Marketing (if used at the facility)

Therapist/Therapy Assistant
Videos
1. ECS Basics Category > Documenting in ECS, Editing, Log In/Exit/Hide, Using the View
Screen, Enter a New Client
2. Clinical > Departments Category > Therapy Administered

Documentation
1. ECS Basics Category > Chat Feature, Documenting in ECS, Editing, Log In/Exit/Hide,

Using the View Screen
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2. Clinical > Departments Category > Therapy Treatment & Notes, Therapy Administered
3. Clinical > Care/Service Plans > Care Plans
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User Setup

Enter a New User

From the ECS System Supervisor Access menu, click onto the Create New User button or
navigate via American Data - ECS > Setup > Security > User. This screen will load all active
users within your facility's database in alphabetical order. Feel free to sort by any other
column, by clicking onto the column heading. Keep in mind that if you only have rights to a
specific facility within a multi-facility database, you will only see users who are in that site.

1. Click onto the New button to create a new user.
2. A User Properties screen will open. See below for a description of each tab.
3. Once all necessary tabs are addressed, click OK to create the new user.

|dentification tab
e Fill in the user's first name, middle name or initial (if known), last name, initials (can be

3-4 characters long), job title, and login name. User initials do not need to be unique.
e Select the Group that the new user should be located in.
e The dot in status will default to Active which is where it should remain if you are
creating a new user. For instructions on a Temp User Status, refer to Enter a New

Temporary User.

Password tab
e Enterinatemporary password into New Password and Confirm New Password boxes.

Unless the user is standing next to you and can type in their own password, a
temporary password may be entered at this time. The following symbols may not be
used in passwords: ; % +

e Place a checkmark in User must change password at next Login if you have setup a
temporary password for this user to get logged in with initially.

e Register Finger Print and Magnetic Card Reader should be utilized in states where that
form of verification is required.

e Place a checkmark in Password Expires if this user should need to reset their password
every so many days (the number of days this occurs is setup in System Settings).

Options tab
e |Ifa user has requested enlarged font throughout the system, this can be adjusted here.

Place a checkmark in Enlarge Menus to increase the font size of button words and pop-
up menus, such as the name selection screen. Then enter in a number for the default
font size (we do not recommend going above 12-14; the default is 8).

e Click onto the F button if the user would also like font size increased on the electronic
MAR/TAR and in view screens. Adjust font size/style appropriately and click OK to save
changes.
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Show Detailed Name List may be checked for those users who would like all basic
resident demographic data on the Name Selection screen rather than only the

resident’'s name. Typically, this is left un-checked.

Show Detailed Name List checked

Name Selection Name Selection ? X
B Adams, John = Morris, Luke J Btest, teset Wima Client Name Site  Status  Disclosure D Record No Bl To  Service Floor unt A
W Adams, Suzanne ¢ B Nixon, Dwight A @ Thiel, Susan T . ) )

&b Andrews, Hannah D B Oiiver, Bethany ] B Thomas, Dwayne A Adams, John SFe 1 Actye 0K 100057 100057 SNF Care 1st Floor East
-Anthony, Susan B. -Peterson, George A -Wetzel, Justin D [ Adams, Suzanne C  Site 1 Active 0K 1 1254 SNF Care 2nd Floor East
@ Baker, Laura B @ Rodriguez, Sally E wilson, Beth A @ Andrews, Hannah D Site 1 Active  OK 200002 451113 Assisted Living  2nd Floor North
M Ben, Jerry N @Roosevelt, Eleanor M Yankee, David H M Anthony, Susan B.  Site 1 Active  OK 100056 1015 SNF Care 1st Floor East
P Carter, Jimmy aPsimonson, Russel L B Zeik, Sharon B i Baker, Laura B Site 1 Active OK 200011 4411511 Assisted Living  2nd Floor  South
=C““e"' Lois M =S?r:tmh Beth O B zrbel, Brooke E MBen, Jery N Stel Actve OK 10350032 10350032 SNF Care 1stFloor East
‘gﬁg'( Jg’;‘; 'g s JC;;’;":T @ Carter, Jimmy Ste1 Acive OK 100060 6485 Assisted Liing  2nd Floor East
B Edwards, Jack C @ Smith, Ronald A i Cullen, Lois M Ste 1 Active OK 10350118 2014-123 Assisted Living 1st Floor South
(] Edwards, Mary ] ‘Sorensen, Lesley E M Doe, Jane Ste 1 Actve OK 10350162 2014-142 SNF Care 2nd Floor North
@ Einstein, Abert @ spears, Britney hDuck, Daisy Ste 1 Actve OK 10350167 2014-149 Assisted Living  1st Floor  East
M Hancock, John M Test 2, Delphi W Edwards, Jack C Site 1 Active OK 54 54 1 SNF Care 1st Floor  West
B Hershey, Darlene  E Test 3, Delphi W Edwards, Mary ] Site1 Active OK 200012 2014-126 SNF Care ist Floor East
&9 Jackson, Henry P. = Test, Charlie W Enstein, Abert Site1 Active OK 100055 100055 SNF Care 1st Floor  North
:;a?fson, JaT“hL - :esstt'toelpth‘ M Hancock, John Stel Active OK 100053 100053 SNF Care None  None
& Jgh:;Z?]n'RenZZBTS = t: i tz:‘e’t 4 MHershey, Darlene  Site 1 Active  OK 58 1305 SNF Care 1st Floor  South

@b Matthews, Clay D

[ test, teset Fred

¢ Show ECS Confirm Close message may be checked if you would like the user to be

presented with the following message when they exit out of ECS: “You are about to

close all tabs and exit ECS.” This may be useful for new users if they have multiple tabs

open and accidently click the “X" which closes out of ECS completely rather than

clicking the “X" on the one tab they meant to close.

e CoSign Use will only be utilized on physician/nurse practitioner users who only want to

see orders within the Electronic Co-Sign tasks that have their name attached to them.
American Data's clinical support staff can assist in determining whether you need to

utilize this for your physician/NP users or not.

Clients tab

e The checkboxes at the bottom (Default Active, Default Inactive, etc.) are for setting
which default clients the user will be presented with upon logging into ECS. A good
standard to follow is that if it is a clinical user, only keep Default Active and Default

Clients Checked (the default settings) in place. Ifitis a financial user, add a checkmark
to Default Inactive and Default Hold. If it is a test user that should only ever have access

to fake clients, only keep Default Other and Default Clients Checked in place.
e The only time that the checkmark in Default Clients Checked should be removed is if

this user does not ever need access to client records. For example, if they are a Human

Resource user, they will not need access to client records, but instead employee

records (which is managed in the Providers tab).
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e Site, Service, Floor, it e -
Unit/Wing, Other, etc.  {UserProperties ! X
may all be restricted for

Identification Password | Options |Cients Vendors | Providers

users If needeol. H: a X'ed items are available for fitering but are not defaulted.
user only works in one St | fenvice | Floor | Unit | Fiter  Type
. . Oan Oan O an [ east Can O an
service of a facility or O] None
only in one facility in a L North
y Y [ south

multi-facility database, O west
then the clients they

L4 > < > < > < > < > < >
have access to can be
. Add add add add add add
restricted here.

o o Remove Remove Remove Remove Remove Remove
Restricting of specific al all all al al al
floors and units may not MDefautActve  []Defauit Other []Default Referral Defauit Clients Checked
be necessa ry however [ |Default Inactive [ Default Hold [_] Default Closed Account
in case staff member

oK Cancel

float throughout the
building. Click Add under any options that need to be restricted down. If an option
should be available to the user, but should not display in their default list upon login
(rather they would have to click Filter and then click onto the appropriate hidden
option), an “X" can be placed into those options. For example, if a staff member works
in the nursing home service 90% of the time, but also serves as an on call nurse for the
assisted living, then you can click Add under Service and list both nursing home and
assisted living. To the left of assisted living, click into the blank box to add a red “X.”
This means that by default the user will only ever see the nursing home clients unless
they specifically filter for assisted living clients.

Vendors tab

This tab will only need to be adjusted if your facility is utilizing our Accounts Payable module
and you are creating a new financial user who manages the AP module in ECS. Follow the
instructions as seen above for Clients tab regarding checkmarks and restricting Site, Service,
and other filter options.

Providers tab

This tab will only need to be adjusted if your facility is utilizing our Human Resources module
and you are creating a new Human Resource user who manages the employees (providers) in
ECS. Follow the instructions as seen above for Clients tab regarding checkmarks and
restricting Site, Service, and other filter options.

Create a Provider
1. Once you click OK to creating a new user, you will be presented with a question, “Do
you want to add a provider for this user?”
2. Click Yes if you anticipate that your facility may ever want to utilize ECS for Human
Resource (tracking of employee evaluations, CEU's, employee health data, etc.)
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3. The Provider/Employee Properties box appears. Some data will auto-populate. Enter
in any additional information that is known or click OK to save the provider and
advance to the Locate screen.

4. Inthe Locate screen, place a dot in Active, and select the Site/Service that this
employee will primarily be working within. Select any other filters which are required
(any in green text must be selected). Click OK once everything has been selected.

Enter a New Temporary User

Navigate via American Data - ECS > Setup > Security > Temporary User. This screen will load
all temporary users within your facility’s database in alphabetical order. Feel free to sort by any
other column, by clicking onto the column heading. Keep in mind that if you only have rights
to a specific facility within a multi-facility database, you will only see users who are in that site.
Temporary users may be utilized for those users that are student nurses/CNAs or are
contracted to only work with your facility for a short period of time.

Refer to Enter New User above for instructions on adding a new user into ECS. The
differences between Temporary and New Users are:
e Temporary users will need dates setup in Activation Time. They will only be allowed
access into ECS during the date range specified.
e Temporary users may only be placed into Temporary User Groups. If your facility does
not already have Temporary User Groups created, this step will have to be done first.
ECS defaults with a Temp User group for CNA’s and Nurses.

Enter a New Portal User

Navigate via American Data - ECS > Setup > Security > Portal User. This screen will load all
portal users within your facility's database in alphabetical order. Feel free to sort by any other
column, by clicking onto the column heading. Keep in mind that if you only have rights to a
specific facility within a multi-facility database, you will only see users who are in that site.
Portal users may be utilized if your facility is using the ECS Portal, which allows family
members, residents, or relatives to access the database with access only to the client record
that you give them access to.

Refer to Enter New User above for instructions on adding a new user into ECS. The
differences between Portal and New Users are:
e There will be an option to include the Relationship the portal user has to the client(s).
e Thereis no tab for Clients, Vendors, Options, or Providers. Instead there is a tab titled
Portal. On this tab, indicate the client record(s) the user should have access to. It may
be that they have access to both their mom and dad'’s charts, so there is a capability to
add more than one client, if needed.
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User Management

Remove/Inactivate a User

If a user is no longer working at the facility, their user profile should be inactivated so they may
no longer access the record.

Navigate via American Data - ECS > Setup > Security > User/Temporary User/Portal User.
Right click onto a user name, and select Properties. Once in here, under User Status, set their
status to Inactive. This will inactive their user profile. To access any inactive users, place a
checkmark in Inactive in the lower right-hand corner of the screen.

Reset a User's Password

American Data cannot reset user passwords. This includes active users, temporary users, and
portal users. Password reset is the responsibility of the facility.

Navigate via American Data - ECS > Setup > Security > User/Temporary User/Portal User.
Right click onto a user name, and select Properties. Once in here, click into the Password tab.
If your facility has HIPAA User Security enabled in System Settings, you will need to know the
Old Password before resetting the new. You will notice in the Password screen that Old
Password is enabled. This must be filled in prior to changing a user’s password.

If the Old Password box is grayed out, you do not need to know the user’s prior password to
reset their password. Simply click into the New Password box and Confirm New Password and
type in what the new password should be. Place a checkmark in User must change password
at next login so that the user may reset the password to what they would like. If their account
was locked due too many invalid attempts, you will notice a checkmark in Account is locked
due to too many invalid login attempts. You will want to remove the checkmark in here before
clicking OK to save the updated password.

Last Name or Title Changes

If a user has a name change or title change (e.g., from CNA to LPN, or LPN to RN), you will
want to Inactivate their current user and create a brand-new user. This is because if you were
to just change the last name or their job title, it will reflect all past documentation as well as all
future charting. Obviously, we need it to be reflected in future charting, but because this is a
legally binding signature in the record, a new user profile needs to be created to reflect
changes going forward. Once the current user is inactivated, all past documentation will
remain with that username and job title. Follow instructions above for Remove/Inactivate a
User and Enter a New User.

800.464.9942 | www.american-data.com




AMERICAN
DATA

Core Training

Logging into ECS

1.

o b W

Double-click the ECS icon to bring up the ECS Authorization Screen.

Enter your login name and password.

Enter a Delay Login for this session, if desired. (See below for details.)

Click Login.

Alternate Login: If the computer you are using has a fingerprint reader on it, you may
scan your fingerprint rather than entering your login name and password.

Once logged into the system, verify your name in the bottom toolbar in ECS as this is
going to serve as your legal signature on all your documentation.

Authorization Screen

= ECS-Electronic Chart System - Authorization Screen (=34

ECS 10 - EMR / EHR & Financial System
DEVI0 (9-7-2017)

1080

Copyright 81996-2017 1984 Systems, Inc. DBA Amenican Datg

» Licensing Information

This is the screen that appears after you double -click the ECS icon.

The LEE] icon brings up a keyboard (if needed).
Click the Licensing Information link to find your Build or version number, as well as
contact information for American Data’s customer support.

Password

Each user will be assigned a password that will need to be changed upon initial login.
Users must select a password that is a minimum of 6 characters long and contain at
least one number or letter based on system settings.

800.464.9942 | www.american-data.com




AMERICAN
DATA

e Users may be required to change their password at regular intervals.

e Afingerprint reader may be used in place of a password.
e Yourlogin and password should never be shared to ensure your electronic signature
remains secure.

Changing your Password

¢ You may be prompted to change your password upon logging into ECS. This may
occur if you were given a generic password when your profile was created. Or, your
ECS may be set to require a password change at regular intervals.

e When you log into ECS on the Authorization Screen, the Change Password screen will
appear. You will be required to complete 3 fields: Old Password, New Password, and
Confirm New Password. Enter your current password (the one you just used to log in)
into the Old Password field. Decide on a new password (at least 6 characters long) and
enter it into the New Password field. Enter the new password one more time into the
Confirm New Password field. Then, click OK to confirm changes.

e Yourlogin name does not change when you change your password.

Delay Login

e This field appears on the Authorization Screen.

e Thisis useful if you are using an ECS application that is set to automatically lock you out
after a brief time, by allowing you to use the shorter password to log back in.

e You may enter an abbreviated password (i.e., if your password is 123456789, you may
enter a 1- or 2-digit password, such as 19).

e Delayed logins are valid for the current ECS session only. The delay login must be reset
each time you log into ECS.

Fingerprint Authorization
e Thisis optional in most states but mandatory in Ohio for completing electronic
Medication Pass.
e If your duties require use of fingerprint authorization in ECS, you will be required to
scan your fingerprint when your user profile is set up.
e When prompted to enter fingerprint authorization, place your fingertip on the scanner.
e Your fingerprint may be used to log into ECS in place of a login/password.

Electronic Signatures

e FEach entry you create in ECS is tagged with “identifiers.” These include the date of the
entry, the time of the entry, and the name, title, and initials of the user logged into the
session.

e Electronic Signatures are legally binding and serve the same purpose as a manual
signature at the end of a note or assessment. For this reason, always make sure you log
off at the end of your session, and that you log yourself in at the beginning of each

800.464.9942 | www.american-data.com




AMERICAN
DATA

session. This helps ensure that no one else can chart with your signature, or that you
chart with someone else’s signature.

Hide/Secure ECS Feature

1.

The Hide ECS feature gives you the chance to lock ECS on the computer you are
working on for a short time if you need to step away from the screen (i.e., medication
pass). This acts like a "bookmark,” keeping your place while preventing others from
seeing the screen or logging you off.

Click the Hide icon or go to American Data - ECS > Hide ECS.

'Hide ECS' may be set to kick in automatically during certain ECS applications (i.e., after
30 seconds of idle time).

When 'Hide ECS' takes effect, ECS is minimized and a screen pops up displaying the
name of the user currently logged into that session. Only that user’s password or Delay
Login will bring ECS back up.

If the user who activated the Hide ECS feature is unavailable to log back in, the session
must be ended by other means, such as Ctrl+Alt+Delete. The procedure may vary
depending upon other variables, such as whether ECS is operating on thin clients or in
a Citrix environment. This is typically worked out with the facility’s IT department.

Exiting ECS

1.

It is important to log out of ECS whenever you will not be actively using it, to ensure
that no other user can access it with your user profile entered.

To close out of ECS, first close out of all the screens that are open. This includes any
documentation, viewing, MDS or other screens that may be open or layered on top of
one another. Each screen that is open is represented by a tab at the top of the screen.
Click the X on the tab to close each tab.

Click the L] in the top right corner of ECS to logout or go to American Data - ECS >
Exit.

Selecting Clients

Most tasks/procedures in the clinical record are client- (or provider-) driven. Whether
you are charting, reviewing charts, or reviewing reports, you will typically need to
define for which client(s) you are doing so.

Most processes in ECS require you to select clients from a Name Selection screen to
complete the process.

o The client list typically defaults to a list of current active clients (except the
business office, which includes all clients with active AR accounts, and Human
Resources, which accesses provider records rather than client records).

o When your user profile is set up, it may be set to show all active clients, or may
be narrowed down to display a specific unit.

800.464.9942 | www.american-data.com




AMERICAN
DATA

o Corporate clinical staff typically has access to clients from all facilities.

Name Selection
W *Facility Services, SHNF 1 [ Nixon, Dwight A

W Adams, Suzanne C M smith, Beth O

M Ben, Jerry N M smith, Carmen

[ Brown, James R W Wetzel, Justin D

[ Edwards, Jack C W wilson, Beth A

@ Edwards, Mary ] E Yankee, David H

[ Einstein, Albert [ Zeik, Sharon B

M Hancock, John M zirbel, Brooke E

[ Hershey, Darlene
M 1efferson, Thomas

[ Morris, Luke 1

select Al Filter Sort Clients ok
— [C] vendors Date 12/18/2017 ... =
Comman Refresh Legend PMulki 0 -
Providers Cancel
12 Mame(s) 0 Selected

Filtering the Client List

e The clientlist has a Filter button at the bottom which allows you to expand or narrow
down the list based on specific filters set on the Demographic screen.

e For purposes of managing the client list, each client is assigned to one of 6 statuses:
Active / Inactive / Hold / Referral / Other / Closed Account. After clicking Filter, you
may add or remove checkmarks from the six (6) statuses to bring up the list of desired
clients.

e Clients may be also be categorized into six (6) filters. The first two (2) are Site and
Service, which are defined by the location of the client on the campus. Four (4)
additional filters are available to be used as needed by the facility. Typical settings for
these filters include: Unit, Med Cart, Floor, CNA Assignment, but may be any filter
needed by the facility. After clicking Filter, you may select from the filters as needed to
narrow down your client list to those clients who share a specific filter (i.e., Unit 1). Hold
the Ctrl button on your keyboard to select more than one filter option at a time from a
category (i.e., Unit 1 and Unit 2).

Using “Common” to Define the Client List

1. The Name Selection screen has a Common button at the bottom which allows you to
narrow down the client list based on entries in clients’ records (i.e., clients in-house on
a certain day, clients with the same doctor, clients with the same religion, etc.).
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Client Search Task -m-
Farmula | I Filter |
Tasks Due
StartDate _ /[ || StartTime _:_ (™) Last Month
EndDate _J_J | Endime _:__ |[..] | © CumentMonth
() Today
) None
Filter Flags Users
Current Active Entries User Name
[ pjc'd Entries

Search Calendar

[ | refresh Client List

Add Remove

Clear Tasks [ within Same Day ["] use Client Linking o wanee]

Click the Common button.

Click the Tasks button.

Select the task(s) you need and click Load.

Select dates (if needed) and click OK.

The client list will be narrowed down to clients that meet the criteria of the common
task.

oA W

Selecting Clients

1. Click the name of the client you want.

2. To select several clients, hold the Ctrl button on your keyboard, or click the Multi
button. Each name you click will remain highlighted.

3. To select a whole section of clients, click the first name, hold the Shift button on the
keyboard, and then click the last name. All names between the two will be highlighted.

4. To select all the displayed names, click the Select All button at the bottom of the
screen.

Switching/Changing Clients

1. For documentation, use the next/previous client arrows to switch to the next or
previous client selected. When only one client is selected, click Name to select new or
additional names.

2. Any screen displaying a Name(s) button allows you to select different names other than
the currently selected one(s).
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Documentation Basics

ECS is based on the idea that when staff enters information into a client’s record, each piece of
information is stored into a Section of the chart (i.e., Face Sheet, Nurses Notes, Physician
Orders) and a specific Topic within that Section (i.e., Social History, Personal Information, Lab
Results). All the stored entries are available to other users and can be pulled together from all
different areas for review. This design eliminates much of the duplication seen in form-based
charting.

Bringing Up a Write Screen
1. Click the appropriate charting button on your easy access screen. For example, to
document Behavior in Nurse Charting, click the Behavior button on the Nursing Access
screen.
2. The other methods are to click the Write icon or go to American Data - ECS > Write >
Entry.

Elements of a Documentation Screen
1. Aclient(s) is selected that the entries are saved to.

Mame(s) | 4 B Brown, James R = I
2. A Section and Topic are selected or defined, in which the entries are saved.
Topic(s) | 4 Murse Charting / Vital Statistics/Symptoms fall = P

3. Alibrary of terms is displayed with a text box below the documenting screen.

4. The documenting screen contains questions and responses pertinent to the topic
selected.

5. Notes and assessments are created by selecting words and phrases from the
documenting screen and adding text as needed to build the note.

Typmg vs. Clicking
Overall documentation should consist of about 50-75% clicking (words/phrases from
the library of terms), and 25-50% typing.
e Clicking key phrases allows the documentation to pull over to MDS, Billing, and
Reports.
e Adding your own text/wording to elaborate on the documentation ensures the
charting is specific and detailed.

Late Entries

Most documentation screens have a word “Late Entry” that can be clicked when an entry
needs to be made for a previous shift or prior date. This word may be selected at the
beginning or end of an entry. It prompts you to select a date which the entry is for.

Defined Review
Most documentation screens display a View screen at the bottom of the screen with data that
is relevant to the charting being completed (i.e., Pain Assessment displays the client's
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Analgesic orders and recent PRN pain medication use). This View screen has all the
capabilities of using the View icon or the View Chart button.

Viewing Records

A View screen allows you to view one record or multiple records at a time. It is a powerful tool
for reviewing charts, identifying clients and risk, and finding clients with common data
elements (i.e., wounds, falls, psychotropic meds, lack of stool output, etc.)

1. There are several ways to pull up a View screen. From an Access screen, click the View

Chart button. Or, click the View icon or go to American Data - ECS > View > Entry.

2. Select the client(s) you wish to review data for (use Filter, Common, and Select All as
needed), and click OK.

3. Select the Topic button to select the Section, Topic(s), or Word(s) you wish to review in
the record(s). Or, click the Task button to select the task(s) you wish to view, and then
click Load and OK.

4. Click Control. Use the Filter tab to select parameters for the search (if needed),
including date range, time range, and/or discontinued entries.

5. Use the Look tab to display entries a certain way, including sorting by topic or in
chronological order, lines between topics, free text highlighter, show names of initials,
etc.

6. Click Go to display the entries.

7. Click any of the Client, Topic, Task or Control buttons to change the selections made.
NOTE: You will need to click Go after changing any selections to display the new
results.

Reports

General Reports

Many of the different access screens have easy buttons linked to commonly used reports. For
example, the Activities Access screen has a column of reports including a Birthday list and
Attendance logs, and the ADT/Face Sheet Access screen has a column of reports including
the Daily Census and the Room/Bed list. To view one of these reports, click the appropriate
easy button, select the desired client(s) from the name selection list, and click OK. To view a
report that may not be linked to an easy button, follow the steps below:

1. Click the Reports icon. Or, go to American Data - ECS > View > Report > General.

2. Select the desired client(s) and click OK. The Report Selection screen appears.

3. Select the report(s) and click OK. Or, click the Tasks button, select the task(s), and then
click Load.
Select dates, times, and users as needed.
Select the Preview checkbox to see a preview of the report before it is printed.
Click OK to display the preview.
When previewing the report, if you wish to change any printing parameter, such as

~No oA

which clients or dates you selected, click the Control button to return to the Report
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Selection screen and then make your change. When you click OK, the report preview
will refresh.

8. Select the printer icon to print, the PDF icon to save to pdf, or click Close when
finished.

Calendar Reports

Several of the frequently used calendar reports are linked to easy access buttons. For
example, the ADT/Face Sheet Access screen has a column of calendar reports including a
Statistics calendar and a Diagnoses calendar. To view a Calendar Report, click the

corresponding easy button, select the desired client(s) from the name selection list, and click
OK.

To view a calendar that may not be linked to an easy button, follow these steps:
Click the Calendar icon. Or, go to American Data - ECS > View > Calendar.

Select the desired client(s) and click OK. The Calendar Report screen appears.
Click the Tasks button, select the desired task(s), then click Load.

Select a date range.

Click OK to preview the Calendar Report.

ok wh =

Click the Control button to return to the calendar task setup if you want to alter clients,
task, dates, or other options.
7. Click the Print button to print the report.

Editing

Only entries displayed on a View screen can be edited. All changes to entries are tracked by
date, time, and user. Entries are never completely removed from the record. Editing rights
vary by user group and responsibility.

1. On a View screen, click the entry you want to edit. This is called “tagging” the entry and
will turn the text red. If you select multiple entries, the first entry you selected will
appear with a yellow highlight.

2. Click the Edit button, or right-click the entry to display the editing menu.

See the chart below for all editing options.

w

4. Complete the Editing action as needed (all the append, new and copy-editing options
involve adding or confirming documentation).
5. Click Go to refresh the screen and display (or remove) changes.

Editing Feature Function Example
Append / Append | Information is permanently Cosigning a student’s
All attached to the entry; further documentation

editing will not be able to be
done to the entry except to
discontinue
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New A new, separate entry made in | Not typically used when editing
the same topic area department notes. Can be used to
see where an entry was charted
Copy An exact copy of the entry is An entry was accidentally

made

discontinued and needs to be made

active again

Copy One (All) to
Other Client[s]

An exact copy of the entry is
made and placed in another
resident’s chart

An entry was accidentally made in
the wrong resident’s chart. Use ALL
if more than one entry was selected

Discontinue and
Append

Entry is discontinued and user is
taken to a Write screen to
document additional notes

An error was made in documenting
the entry and the user would like to
explain why the entry is being
discontinued

Discontinue and
New

Entry is discontinued, a new
entry is made in its place

Not typically used when editing
department notes

Discontinue and
Copy

Entry is discontinued, copy of
entry is displayed allowing user
to make changes to the original
entry

User forgot to use a button word
when documenting and would like
to ‘insert’ the word into the entry

Discontinue

Entry is discontinued

Not typically used when editing
department notes

Discontinue All

All highlighted entries are
discontinued for one client

Not typically used when editing
department notes

Discontinue

All highlighted entries are

Not typically used when editing

Multiple Client discontinued for multiple clients | department notes
Entries
Skip Allows user to skip a Highlighted an entry that does not

highlighted entry

need editing

AMERICAN

Other Features

Layering Screens

1. Each screen is represented by a tab at the top of the screen.
2. If you have more tabs open than can fit on the screen, you can use the arrow buttons

$9 ¢ ks Q":'| to bring tabs into view. Click > to scroll to the right. Click >> to move the
screen to the furthest tab on the right. Click < to scroll to the left. Click << to move the
screen to the furthest tab on the left (Toolbar tab).

3. Click American Data - ECS > Window. From here, you can “tile” (side-by-side) or
"cascade” (top-to-bottom).

4. Each open screen must be exited prior to exiting your ECS session.
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Internal Communication
An internal email system for ECS users.

Messages can be set up to happen automatically (i.e., when it is charted that a client
falls), or created manually by clicking words or topics to send messages to others.

You can access your messages by clicking the envelope icon %0 5n the bottom
toolbar. This icon will be covered by a number in a red circle to indicate how many
new messages the user has. If the user receives more than 9 new messages, the icon
will be covered by an exclamation point in a red circle. If the user has 10 or more
unread messages, the envelope will be covered by an exclamation pointin a yellow
circle. Users can also hover over the envelope to view the number of unread messages.
Unread messages are indicated by bold font.

To delete a message, highlight it and select Delete.

NOTE: Deleting messages does not remove the chart entries within the record.

Store messages in yellow file folders by right clicking into the blank space to the left of
the messages and selecting New Folder. The folders can be moved up and down in
the list by using the double up and double down arrows on the bottom of the screen.
Use the *Memo client to create messages not specific to a resident. Select the Memo
Section and Topic to write these messages.

Some messages may indicate that a co-signature is required. Edit and Append the
entry if you are required to cosign.
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Using Fake Residents for Practice

1) Log into ECS using your login username and password.
2) Click Filter on the Name Selection screen.

Name Selection
O *Facility Services, SNF 1 E Nixon, Dwight A
[ Adams, Suzanne C [ Smith, Beth O
EBen, Jerry N [ Smith, Carmen
E Brown, James R E wetzel, Justin D
[ Edwards, Jack C E wilson, Beth A
O Edwards, Mary 1 O yankee, David H
[ Einstein, Albert @ Zeik, Sharon B
EHancock, John [ Zirbel, Brooke E

[ Hershey, Darlene
[ 1efferson, Thomas

E Morris, Luke ]

Select Al Filter sort clients o
Date 15/2017 L
Common Refresh Legend Tk ol ".-’enc.lurs e
Providers Cancel
19 Mame(s) 0 Selected

3) Remove the checkmark from Active and place a checkmark in Other.
4) Click OK.
5) Select any resident(s) from this list and click OK.
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Training Handout for Surveyors

Login to ECS

Double click the ECS icon. Enter your login name and password on the Authorization screen
and click Login.

Your login name is:

Your password is:

Pressure All Nurses Physician
Hide ECS Ulcers Falls Elopement PASARR MDS Not Charting
. . Change of Advanced CNA
Dialysis ADL Status Condition Directi CAAs Documentation| MARs
" Bowel and Physician . Restorative
Infections Bladder Orders Hospice Care Plans Charting TARs
Nutrition Hospitalization| Diagnoses Services Face Sheet Cj ha“:h m". ity View Chart
I Charting ng
Secure ECS During Idle Time B £CS Login - Hide / Timeout
1. From the Access screen, click the Hide

ECS button.
2. The Hide/Timeout screen appears. Only

the same user can log back in.
3. Tolog backin, enter your password and

click Login. ECS 10 - EMRI EHR&Financlal System

View Chart Entries

From the above access screen, click the button
related to the information you wish to review. ? B3
Select resident name(s). Click OK to load the
task. Once the View screen begins to load, you may see one of two options:

—
]

1. You are presented with a date popup prompting you to select a date range. If so,
select the Start Date and End Date and click OK. Once in the View screen, click Go to
tell the system to search for the data. Or,

2. The View screen may load automatically as it does not require dates or already has a
selected period attached to it (typically 460 days’ worth).
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To adjust the font size within the View screen or to print the data, click onto the More...
button. This will then give a Print button as well as a big and little “A” which can be used to
adjust font sizing.

Toolbar Easy - [Surveyor [2017]] IView - [Surveyor - Murses Motes] 23

Exit Mamels) |« | Topic Tasks Date From Date To Control Go Edit Next Split
[-+[1] Erown, James R 03/26/1942 75'rs M Site 1 East 106-2
HE 10/09/2017 04:12PM HDC  PULSE:
F11/15/2017 10:18AM HDC  BEHAVI
g‘éﬁiﬂ Toolbar Easy - [Surveyor (2017]] IView-[Sur\reyor-Nurses Motes] &2
BEHAVT Exit Mamels) | = | Topic Tasks Diake From Date Ta Control Go Edit Mext Split Less...
BEHAVT
IMPACT| Legend | Refresh 5_‘ b | Tagall | Untagal |+
BEHAVT) ———— !
s1eniF| =/ Brown, James R 03/26/1942 75%rs M Site 1 East 106-2
SIGNIF: [ 10/09/2017 04:12PM HDC  PULSE: 56
F 10:18AM HDC  FOLLOV 11/15/2017 10:13AM HDC  BEHAVIOR: hitting / scratching self behavior occurred 1-3 days in the last 7 days,
PHYSIC IMPACT ON RESIDENT:
MNOTIFIT BEHAVIOR PUT RESIDENT AT SIGMIFICANT RISK FOR PHYSICAL ILLMESS OR INJURY? yes
INJURY| BEHAVIOR SIGMIFICANTLY INTERFERED WITH RESIDENT CARE? yes
ACTION BEHAVIOR SIGNIFICANTLY INTERFERED WITH RESIDENT'S PARTICIPATION IM ACTIVITIES OR SOCIAL INTERACTIONS? yes
IMPACT ON OTHERS:
BEHAVIOR PUT OTHERS AT SIGNIFICANT RISK FOR PHYSICAL INJURY? no
SIGMIFICANTLY INTRUDE OMN THE PRIVACY OR ACTIVITY OF OTHERS? no
SIGMIFICAMTLY DISRUPTS CARE OR LIVING ENVIRONMENT? no

View MARs and TARs

1. From the access screen, click onto

Sign Print ? x
MARSs or TARs. Report Type
2. Select resident name(s) and click Name(s) | []RoomOrder [ ]Lower TopMargin (® Summary Report
OK. A Sign Print window will Task | [Meds Al (Summary) () Exception Report
appear. 21 0e Month per . . (O send Order Log
e per Page eparate Montns
Count
3. Sele;t the déte range.you.would [JEnties Actve by Date Range [ JShow P Ow ount
like view, adjust font size (if [Juse Color for HeldRefusedmeds ~ FontSize 8 O signature Details
needed).
. Print
4. Once everything has been o e el
selected, click Print. This will
! ] ) Start Date-04,-'25,-‘zulu «v | End Date [05/08/2020 | ...
present you with a preview of the Cancel

MAR/TAR prior to determining
whether you would like to print or save the document.

View MDS

1. From the access screen, click onto the MDS button.

Select resident name(s) and click OK.

A list of the resident’'s MDS' will appear in the MDS Selection Screen.
Select the MDS you wish to review and click OK.

The MDS will preview.

2.
3.
4.
5.
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View CAA's

1.

ok w

From the access screen, click onto the CAAs button.

Select resident name(s) and click OK.

A list of the resident’'s MDS' will appear in the MDS Selection Screen.
Select the MDS you wish to review CAAs for and click OK.

The CAAs report will appear in a print preview screen.
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Client Sign On Guide

Dashboard

Upon log in, you will be taken to the Dashboard. On the Dashboard you can find recent
announcements, a link to the forum, and the latest materials posted in each resource section.
Clicking "Dashboard” from anywhere in the site will take you back to the Dashboard screen. In
the Navigation Bar, you will see options in the menu for each resource area of the site.

Dashboard Updates v Videos v Documents v

Updates

The Updates page provides links to download the latest ECS Software Updates as well as
access past updates.

Videos

Under the Videos tab, you will find links to the Training Videos page, the Upcoming Webinars
page, and the Past Webinars page. American Data offers a wide variety of training videos,
categorized for your convenience.

Documents

Under the Documents tab, you will find links to the Support Documents page and the
Newsletters page. All documentation from the ECS User Manual is available in the support
documents page. Simply search by keyword to bring up all documents containing the desired
terms or browse the list of articles. From the Newsletters page, you may access current and
past newsletters, as well as the form to subscribe to our email lists.

User

Under the User tab, you will find links to the Your Profile page, the ECS User Forum page, the
Contact Us page, as well as the logout button. If you are logged into your Facility’s account,
you will also see links to the Staff Directory page and the Add Staff page.

ECS User Forum

Interact with other ECS Users and American Data Staff to discuss recent updates, new
features, important announcements and all things ECS. To comment or start a discussion,
locate the Sign In button in the right- hand panel (A). Then click “Sign In with American Data
User” (B).
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A. B
Sign In
Howdy, Stranger!
It looks like you're new here. If you .
want to get involved, click one of Email/Username Oryou can...
these buttons! CARES Admin
) Sign In with American
CARES Admin Data User
Sign In with American Data Password
User
‘ SIGN IN ‘
Forgot?

Updating Your Profile

The "Your Profile” page is where you can
find and update the primary contact
information for your facility. It is important
to update this form in the instance of a
new administrator, a change of email
address or a change of phone number.

Please note: The Business Name and
Username field cannot be changed.

If needed, you may change your
password in the “New Password” field.

Do not forget to save the updated
information by clicking the "Update”
button at the bottom of the page.

The page will reload, and you will be
informed your changes were successfully
made at the top of the form.

Forgot Username/Password

If you happen to forget your username or
password to log into the Client Sign On,
you may use the “Lost your Password?”
link on the log in screen. This will prompt

Please fill out the form below.

Avatar

Business Name

Business Names cannot be changed.

Contact Name * CARES Admin

i| *
Email cares@american-data.com

*
Phone 1-800-464-9942

Username

Username cannot be changed.

New Password

Confirm New Password

Strength indicator
Hint - The password:

- Should be at least 5 characters long.
- Must trigger the Very weak level on the Strength indicator.

UPDATE

you to enter the email address tied to your account and will send an email with instructions on
how to reset your password. The email will display your username.
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Username:

Password:

@ Remember Me

Lost your password?

Facility Administrator Log In

As a Facility Administrator, you log into the Facility Account using the username provided by
American Data. You will have the responsibility to register and create the profile for each
member of your staff, so they have the ability to log into their own Staff Account. After initial
registration, you will have the ability to add, edit, and delete staff members from your staff
directory. Your staff members will have the ability to edit their own contact information after
initial registration. It's important to keep this information up to date so we know the right
contacts are receiving important ECS announcements.

If the Administrator or ECS System Supervisor at your facility changes, American Data will need
to update the contact information of the person tied to the Facility Account. It's important to
do this prior to the contact person’s last day so American Data receives permission from the
account holder to update the account. To do this, please email cares@american-data.com with
the current account holder’s approval and the new contact’s information, or call 1-800-464-
9942.

Adding Staff

Itis important to add new staff members to keep your staff directory up to date.

800.464.9942 | www.american-data.com




AMERICAN
DATA

Under the "User” section of the menu, click “Add Staff” in the drop down to fill out the form.

Staff Login

E-mail

Contact Name

Job Title

Phone

Facility Name

Password

Confirm Password

Fill out the form accordingly.

Dashboard Updates v Videos v

Example Staff

ExampleStaff@example.com

Example Staff

Example Title

17111111112

Example Facility

Hint - The password:

|

Send this password to the Staff by email.

Check to Enable

ADD NEW STAFF BACK
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Your Profile
Staff Directory
Add Staff

Contact Us

Logout

Staff Login: Enter in the desired
username for the staff member.
We recommend using the staff
member’s first and last name.

Password: Enter in a temporary
password for the staff member to
use. This can be changed by the
staff member after log in.

Fill out the other required fields
with the contact’s information.

Be sure to check the box "Send this

password to the Staff by email” so
they will be notified their profile

was created.

Once the form fields are correctly
filled out, click the “Add New Staff”
button to save the information.

You will then be redirected to the
"Staff Directory” page where you
can see your staff member was
successfully added.
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Editing Staff

In the instance a staff member is no longer with your facility, you may remove the staff
member’s contact information by clicking “"Delete” under their name. If a staff member’s
contact information changes such as an email address, phone number, or job title, these fields
can be updated by clicking "Edit” under the staff member’s name.

Dashboard | Add Staff

Staff Email Address Contact Name Job Title Phone Facility Name
CARES Staff info@american-data.com CARES Staff CARES Staff American Data
Edit | Delete
New Staff Member NewsStaff@gmail.com New Staff DON 000-000-0003 American Data
Edit | Delete

You will then be redirected to the "Edit Staff” page where you can update the information in
each field. Please note: "Staff Login” and “Facility Name” cannot be changed.

If needed, you may change the password in the "Password” field. If a password is changed, be
sure to check the box “Send this password to the Staff by email” so the staff member will be
notified via email.

Once you have made all the necessary changes, click the “Save Staff” button to save the
information. You will then be redirected to the Staff Directory page where you can see your
changes were successfully saved.
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